


Learning to Get Along
Talking books for teaching social skills

Learning to Get Along Software is a social sk ill and character
education program for children ages 4–8. The software series
features 15 well-written, attractively illustrated stories that
consistently model appropriate social sk ills and positive
behaviors for young learners.

The software reads the books aloud with highlighted text and
lets students click  on any word for identification. You can
assign books to each student and select the highlighting
method (word by word, line by line, or sentence by sentence).
Engaging questions with speech at the end of each story
challenge students and provide you with data on
comprehension.
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Quick Start

Thank you for your interest in Learning to Get Along, a series of 15 talking books for

children ages 4-8. This interactive software series teaches critical social skills while

supporting reading, listening and comprehension. Each book has a different theme and

includes full-color illustrations, highlighted text and professional narration.

If you wish to print this User Guide, it is available in the following locations:

1. On the CD or DVD containing the program.

2. In Windows, from Start menu: Programs  Attainment Company  Documentation 

Learning to Get Along manual.

On the Mac, inside the program folder: Attainment Company  Learning to Get Along.

3. Downloadable from the Attainment Company website, www.attainmentcompany.com

To download: Type "Learning to Get Along" in search window, then click on "Learning to Get

Along Software." 

You will see a PDF link on this page.

Starting the Program

To start the program in Windows:

Go to Start menu at bottom left of screen.

Click Start  Programs  Attainment Company  

Learning to Get Along.

To start the program on the Mac:

Click on Go pulldown menu and find Applications list.

Find Learning to Get Along

Double-click Learning to Get Along.app

http://www.attainmentcompany.com
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Logging In

The login screen will come up when the program starts. Select a user’s name from the Name

pull-down list, or click the Guest button, and click OK.  When there are no user names, the

program automatically logs in as Guest and the login screen does not appear.

To create user list, see Options
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Reading Stories

The story directory on the main menu lists 15 stories on two screens, shown as square

buttons. Click the More or Back button to see all story choices. Clicking on a story's button

brings up its title page. 

 

On the title page, click the Read button to begin the story, or the EXIT button to return to the

story directory.
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The Next and Back buttons move forward or backward through the story. Click EXIT to

return to the story directory.

When a student who has logged in finishes a story, the story icon will be either shaded or

removed, depending on the setting.

The completed story will also be recorded in the logged-in student's Results. For more

information, see Results.
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Story Directory

The story directory is on the main menu of Learning to Get Along. Select stories to read

from this menu.

You can also perform other functions, via auto-hidden pull-down menus at the top left of the

screen.
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The File menu allows you to:

1. Log out one user, to log in another.

2. Go to Options to add or delete users, or select

features for each user

Password is required.  Built-in passwords attainment and

freespirit always work, or you may create your own in the

Options menu.  See "Teacher Password"

3. Quit the program
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The Sound menu allows you to turn off the

music, speech, and/or special effects sounds.

NOTE: This only affects the current session.

Turning sounds off for a particular student is

done in the Options menu.  See "Sounds"

The Help menu takes you to the

program's user guide, as well as

information about the program.

Adding Users

LOCATION:  File  Options / top of screen
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Click the Add button to add a new student user. Type in the student’s name and click the

Next button. 

Choose User Password: After clicking the Next button, you’ll be prompted to assign a

password.  This is optional and can be skipped.  If you do not designate a password, the

user can log in by selecting his or her name from the pull-down login menu.
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Choose User Icon:  After choosing a password, you may also assign an image, for

example a photo, to the user’s name. This is also optional. If your computer is camera-

enabled, you can click on "Snapshot" to create a photo for the user's icon.
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Password and Icon assignments can be added or changed later via the Settings button 

System tab.

All of the users will appear in a pull-down list. To change program options for a particular

user, select that user from the pull-down list, then click on the Settings button.

NOTE: If on a Mac, you must be logged in with the name you used when creating the list of

users, or you will not see the list.

To delete a user:  Bring user's name up in drop-down list, then click Delete.

See  Options overview for more information.
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Seeing and Hearing the Stories

Story Audio

To hear a paragraph, click the triangle to its left.

To hear a single word, click directly on the word.

To restart the story narration, click on the triangle, or double click at the point you want the

narration to resume.

Speech balloons, signs, labels, and other words on the page are also spoken. Click

directly on the words to hear them.

The mouse pointer will change from an arrow to a hand when it rolls over any readable text.

By default, spoken text begins automatically after each page turn. This auto read option can
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be disabled.

The text is read as natural speech, in a conversational tempo. Slower, word-by-word speech

is also available.

See:

Narration Style to change speed of speech

Story Options to turn off automatic narration

Highlighting

As the story is spoken, text is highlighted one word at a time, in yellow.

Highlighting can also be by sentence, by line, or turned off, and the highlight color can be 

changed.

See Narration Highlighting.

Glossary Words

Glossary words have a gray underline. When a glossary word is clicked, a definition

appears, and the word and its definition are heard.



Seeing and Hearing the StoriesLearning To Get Along 17

© 2011 Attainment Company, Inc.

The cursor prompt looks different when the mouse moves over a defined glossary word,

changing from an arrow to an arrow with a question mark.

The glossary feature can be turned off, if desired, in Options.  See Story Options.
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Story Activities

Think About It

Immediately following each story is a screen with the heading "Think About It."

This screen sums up the message of the story with a bulleted list.

There are no questions to answer on this page.

Quiz

Each story has three multiple-choice questions. The questions are read automatically. Click

the button next to each answer to hear it read.

The My Answer button chooses the selected answer.
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If the answer is correct, the student will see and hear a positive response for a moment, and

then the screen will change to the next question. If an answer is incorrect, the student will be

encouraged to try again, and then the question screen will restore with the first answer

shaded out. The program will not move to the next question until the correct answer is

selected.

  

After the final question has been answered, a new screen will appear to congratulate the

student for knowing new information.

Note, the quiz can be made unavailable.  See Test Options.
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Talk About It

An optional screen following the multiple-choice section has a voice recording function,

which will record the student’s verbal response to the question using a microphone.

NOTE: This feature is disabled to start. It must be enabled in Options Settings menu.

To make it available for all your students, enable it while logged in as "Guest."

To record the student’s voice, click on the Record button. The recording time is 10

seconds and is indicated by a red progress bar.

To stop the recording before 10 seconds, click on the Stop button.

To play back the student’s voice, click the Play button.

This feature will only be available if the computer is microphone-equipped. It can also be

turned on or off for each student.  See Test Options for more info.

The voice recording can be listened to in the student's Results.  See Results for more info.



OptionsLearning To Get Along 21

© 2011 Attainment Company, Inc.

Options

Options Overview

LOCATION:  Auto-hidden menu in story directory:  File  Options

                                      

The Options menus let you add or delete users, and change settings for individual students.

In the top level options menu, you can:
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* Add new users.   Add User

* Delete a user.  Bring user's name up in drop-down list, then click Delete.

* Make changes to general (non-user) options.  Fullscreen; Allow Guest Logins; Teacher

Password.

To make changes in a student user's options, click on the Settings button.

See settings listed below.

To see a student user's quiz results, click on the Results button.

TIP:  To change default settings for all new users, select Guest from the pull-down menu

of users, and then change the settings.

See Factory Settings list.

Settings that can be changed:

Narration Style for speed of speech

Narration Highlighting for items highlighted and highlighting color

Story Options to turn on/off:

* narration starting automatically after each page turn

* page turning automatically after it has been read

* definitions of vocabulary words appearing

Test Options to turn on/off:

* quiz questions

* "Talk About It" feature

Scanning to enable automatic scanning

Sounds to turn sounds off
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Add User

LOCATION:  File  Options / top of screen

Click the Add button to add a new student user. Type in the student’s name and click the

Next button. 

Choose User Password: After clicking the Next button, you’ll be prompted to assign a

password.  This is optional and can be skipped.  If you do not designate a password, the

user can log in by selecting his or her name from the pull-down login menu.
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Choose User Icon:  After choosing a password, you may also assign an image, for

example a photo, to the user’s name. This is also optional.  If your computer is camera-

enabled, you can click on "Snapshot" to create a photo for the user's icon.
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Password and Icon assignments can be added or changed later via the Settings button 

System tab.

All of the users will appear in a pull-down list. To change program options for a particular

user, select that user from the pull-down list, then click on the Settings button.

NOTE: If on a Mac, you must be logged in with the name you used when creating the list of

users, or you will not see the list.

To delete a user:  Bring user's name up in drop-down list, then click Delete.

Factory Settings

This is a list of the initial program settings. They can be altered for an individual user or for

Guest.

NOTE: Settings for Guest are the default values when adding new users.
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Narration Style: Natural Speech

Narration Highlighting: By Word

Auto Read: checked

Auto Page Turn: unchecked

Glossary Lookups:  checked

Take Test: checked

Talk About It:  unchecked

Story list: all stories available

Autoscan: Disabled

Debounce: Disabled

Sounds: All three checked [music, speech, special effects]

Fullscreen: checked

Allow guest logins: checked

Fullscreen

LOCATION: File  Options, at bottom of screen

  

If Fullscreen is checked, there is no menu bar and the window cannot move.

If unchecked, the window can be moved and resized. The text and pictures will not resize.

Allow Guest Logins

LOCATION: File  Options, at bottom of screen
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If Allow Guest Logins is checked, allows users to log in as "Guest."

If unchecked, only named users can log in.

Guest login is automatic if no users are added.

Teacher Password

LOCATION: File  Options, at bottom of screen

  

Create a new personal password, of one character or more, that can be used to access the 

Options menu.

Built-in passwords "attainment" and "freespirit" will always work.

Program Settings tab

LOCATION: File  Options Settings button First of three tabs

  



OptionsLearning To Get Along 28

© 2011 Attainment Company, Inc.

In this tab you change the settings for narration style, highlighting, auto reading and auto

page turns, glossary lookups, and test options. The name of the user whose settings are

changing is displayed at the top.

See:

     Narration Style

     Narration Highlighting

     Story Options

     Test Options
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Narration Style

LOCATION: File  Options Settings button Program Settings tab, 1st
column

  

Choose between three speech options: Off, Natural Speech, and the slower Word By Word

speech. 

Narration Highlighting

LOCATION: File  Options Settings button Program Settings tab, 1st
column
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Choose between four highlighting options: Off, By Word, By Sentence, or By Line.

You can also change highlight color.

NOTE: Highlighting of the text goes along with audio.

If there is no story narration, there will be no highlighting.

Story Options

LOCATION: File  Options Settings button Program Settings tab, 2nd
column

  

When Auto Read is checked, story narration will begin a moment after page is turned,

whether page is turned automatically or manually.  Clicking anywhere on the page will turn

auto read off, but it will start up again on the next page.

When unchecked, audio narration is triggered by clicking the arrow next to a paragraph, or

by double clicking inside the story paragraph.

When Auto Page Turn is checked,  the page will turn automatically after the last sentence

on the page has been read. It is possible to inhibit this function by clicking on the page

immediately after the last sentence has been read. If so, automatic page turning will start up

again on the following page.



OptionsLearning To Get Along 31

© 2011 Attainment Company, Inc.

When unchecked, clicking the Next button will turn the page.

Auto Read and Auto Page Turn can be turned off and on independently, but are often used

together.

When Glossary Lookups is checked, vocabulary words are underlined on the first page

where they appear. Underlined vocabulary words can be clicked to reveal the definition,

which is also highlighted and read out loud.

When unchecked, vocabulary words are not underlined, and their definitions cannot be

accessed.

Test Options

LOCATION: File  Options Settings button Program Settings tab, 2nd
column

  

If Take Test is checked, three multiple-choice questions follow the story and "Think About It"

page.

If unchecked, the "Think About It" page completes the story.

Following each story is a quiz consisting of three multiple-choice questions, followed by "Talk

About It," a voice recording feature. These may be turned on independently or together.
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NOTE: By default, Talk About It is unchecked.

If Talk About It is checked, the "Talk About It" screen following multiple-choice questions is

enabled.

This feature requires a microphone to record audio, and is not available for the Guest user.

Stories tab

LOCATION: File  Options Settings button Second tab

  

Story lists for each student can be customized. Check or uncheck stories to display or hide

them in the student’s directory.  All stories are checked by default.
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Treat Completed Stories As Removed:

Stories are considered complete when all available pages have been viewed, whether or not

quiz was done.

If checked, story icons are removed from the student’s story directory.

If unchecked, completed stories are grayed out as if they are not available. However, they

can still be selected to read again.
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System tab

LOCATION: File  Options Settings button Third tab

  

The System tab allows you to change a user’s password, icon, scanning settings and sound

settings.
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Student Password

LOCATION: File  Options Settings button System tab, 1st column

  

Optionally assign a password for the current student user. If no password is entered, the user

will be able to log in by selecting his or her name from the pulldown menu and clicking "OK."

Scanning

LOCATION: File  Options Settings button System tab, 1st column

  

Also see Alternative Access.

Scanning: Choose Single Switch (automatic), Double Switch (manual), or Disabled. When

"Disabled" is chosen, all of the other fields are grayed out and cannot be selected.
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Autoscan Delay:  Available when

Single Switch is chosen. Select the

length of time the cursor dwells on each

selection when automatically scanning,

between 1 and 8 seconds.
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Scan Next:  Available when Double

Switch is chosen. Choose the

keyboard key which will advance to the

next scanned field when manually

scanning. When using a switch or

button, determine which key is

programmed to the device.

Scan Select:  Available for both Single

Switch  and Double Switch. Choose the

keyboard key which will make a

selection while scanning. When using a

switch or button, determine which key is

programmed to the device.
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Debounce:  Available for both Single

Switch  and Double Switch. Select the

length of time in which repeated

selection is ignored, between 1 and 3

seconds. Helps to prevent unwanted

selection with palsied or hyperactive

users. Debounce can be disabled if not

needed.

Available for both Single Switch  and

Double Switch.

Highlight size: Select the weight of

the highlight border which indicates

current choice. Choose between

Normal, Large and Extra Large.

Highlight color: Select the highlight

color which indicates current choice.

Choose between red, yellow, and

green.

See sample below:  Extra Large Red scan selected.
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Sounds

LOCATION: File  Options Settings button System tab, 2nd column

  

Sound:  Theme music, narration audio, and sound effects (such as button clicks) can be

independently turned on or off for any individual user.
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Sounds can also be turned off in a pull-down menu at the top of the story directory.  However,

they do not change the user's settings.  If sounds are disabled in the Systems tab, they can’t

be enabled in the story directory’s pull-down menu.

Student Icon

LOCATION: File  Options Settings button System tab, 2nd column

  

Student Icon:  Optionally add, delete, or change an image that’s paired with a student’s

name on the login screen. Create an icon from any available graphic file. If computer is

camera-enabled, you can create an icon by clicking on "snapshot."

If no icon is created, only the user’s name is displayed on the login screen.

Results

LOCATION: File  Options Results button
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Every story that a logged-in student completes, and every test result, is recorded in the

program. To view students' results, go to File-->Options. With user selected, click on the

Results button.

NOTE: Results are never recorded for a "Guest" user.

Stories Read

If Take Test is unchecked in Options, the Results button will indicate that the story was

read.

Quiz Results

To see the score, date, and time of each quiz taken: In a user's Results tab, click the plus

sign next to a story.
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The score is based on the number of tries required to answer each question correctly. If the

user takes a quiz more than once, each quiz's results will be recorded.

Explanation of percentages:

100% would indicate the correct answer for all three questions was selected on the

first try

50% would indicate that, on average, questions were answered on the second try.

0% would indicate that for all three questions, the correct answer took three tries.
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To see more detailed information: Click on a particular quiz, and then click the View button at

right. A new screen will appear with each question, the number of tries it required to answer,

and the correct answer in brackets.  Click EXIT to go back to Results screen.

This screen can be both viewed and printed.

Talk About It

If the user recorded an answer in the Talk About It section, that answer appears as question

#4. Click on the phrase "voice recording" and then Play to hear the user's answer.

Click the Delete button to delete the selected quiz results.
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Alternative Access

Touch Screen 

Program is compatible with touch screen devices.

Intellikeys

We provide an Intellikeys overlay document in PDF form on the CD.  You can also

download this document from our website, on the "Read to Learn software" product page.

Scanning

This program supports single- or two-switch step scanning.  To change scanning settings, go

to Options menu, Systems tab.  See Scanning for more detailed information.
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License

Ownership

Attainment Company retains the title to the software program. The purchaser gains only the

title to the enclosed CD.

Copyright

This program is protected by United States copyright laws and International copyright

treaties.

Upgrades

If within 30 days of this software purchase Attainment Company releases a new version of

the software, you may send the enclosed CD to Attainment for a CD containing the new

software at no charge. After 30 days, you must pay an upgrade fee.

Warranty

Attainment Company warrants that the enclosed CD is free of defects in materials and

workmanship for up to one year of purchase. If you discover a defect, return the enclosed CD

to Attainment Company for a free replacement. There is a replacement charge of $15, plus

shipping and handling, for products replaced after warranty expires.

Limitation of Liability

Attainment shall not be liable for damages, including incidental or consequential, arising from

the use of the program or this documentation. Some states, however, do not allow the

limitation or exclusion of liability for incidental or consequential damages. In these cases, this

limitation may not apply.
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Contact Information

For questions and comments about the Learning to Get Along software, contact:

Attainment Company, Inc.

1-800-327-4269 or 1-608-845-7880

info@AttainmentCompany.com

www.attainmentcompany.com

Click HERE for the "Learning to Get Along" page on our website.

____________________________________________________________

For questions and comments about the Learning to Get Along stories, contact:

Free Spirit Publishing

1-800-735-7323

help4kids@freespirit.com

www.freespirit.com

mailto:info@AttainmentCompany.com
http://www.attainmentcompany.com/product.php?productid=16550&cat=0&page=1
mailto:help4kids@freespirit.com
http://www.freespirit.com
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Technical Support

If you have a problem running Learning to Get Along software, please call Attainment

Technical Support at the number below. If possible, have the program running with your

computer nearby while we discuss solutions. 

You can speed the process if you collect some basic information ahead of time:

* What was the error and type of error message, if any?

* What triggered the problem?

* Can you duplicate the problem?

* What operating system are you running?

Tech Support is available weekdays from 9 am–5 pm (CST)

phone: 1-800-327-4269 or 1-608-845-7880

email: info@AttainmentCompany.com

website: www.AttainmentCompany.com

mailto:info@AttainmentCompany.com
http://www.attainmentcompany.com
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System Requirements

Windows - System Requirements:

* Windows XP SP3 or higher

* Minimum of 512MB RAM

* Microsoft .Net 3.5 SP1

NOTE: During installation from the Autoplay menu, if .Net v3.5 is not detected, you will be

prompted to install it. .Net 3.5 SP1 is included on the CD.

Mac - System Requirements:

* Intel processor

* OS 10.5 or higher

* Minimum of 512MB RAM

* Microsoft Silverlight

NOTE: During installation, if Silverlight is not detected you will be prompted to install it. The

Silverlight installer is included within the program. Once Silverlight is installed the program

will start.
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